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Now that you know a little bit about the ArcView Image Analysis
extension and its potential applications, the following exercises give you
hands-on experience in using many of its tools. By working through the
exercises, you are going to use the most important components of the
ArcView Image Analysis extension and learn about the types of problems

it can solve.

You’ll perform the following exercises using the ArcView Image
Analysis extension:

* Exercise 1: Adjusting the appearance of an image.

» Exercise 2: Identifying similar areas in an image.

* Exercise 3: Aligning an image to a feature theme.

* Exercise 4: Finding areas of change.

» Exercise 5: Mosaicking images.
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Using ArcView Image Analysis

Exercise 1: Adjusting the appearance of an image

Image data, displayed without any contrast manipulation, may appear either too light or
too dark, making it difficult to begin your analysis. The ArcView Image Analysis
extension allows you to display the same data in many different ways. For example,
changing the distribution of pixels allows you to alter the brightness and contrast of the
image. This is called histogram stretching. Histogram stretching enables you to
manipulate the display of data to make your image easier to visually interpret and
evaluate.

Depending on the original distribution of the data in the image, one stretch may make
the image appear better than another. The ArcView Image Analysis extension allows you
to make those comparisons rapidly.

In this exercise, you use an image of Moscow, Russia. You can apply different histogram
stretches to the image to change its appearance. To create a negative of the image, you
can apply an Invert Stretch.

Start ArcView GIS

Load the ArcView Image Analysis extension
1.  From the File menu, choose Extensions.
2. Click the Image Analysis check box.

3. Click the OK button on the Extensions dialog to load the extension,

Database Access
Dialog Designer

Digitizer

Geoprocessing

Graticules and Measured Grids
Image Analysis

IMAGINE Image Support

I Extends ArcView to support image piocessing by ERDAS {v1.1).

Choose the Image Analysis extension from the Extensions dialog.

Note You can click the Make Default check box so that the ArcView Image Analysis
extension is loaded every time you start ArcView GIS.
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Add and draw an Image Analysis theme of Moscow

1. Open a new view.

e or 2. Click the Add Theme button v ]
ff, the 3. Navigate 'to the avtutor directory. Double click on the ia_data directory under the
avtutor directory.
» 4 . i . .
'\/ ™ AT; . g(l,l,ji gle Data Source TYpeS‘dro Pdﬂoswn (yl‘I)St a‘rﬁ c'h(’i}(}s:ejrgftiﬂ‘ A‘m}l}’;isv ?Zal $30 / A
ke wu"rﬁ 6,\) 5. Double-click on moscow_spot.tif to add it as a theme. IA, 0 A m
vs you . 6. Click the check box to draw the theme in the view.
7.  With the Moscow_spot.tif theme active, click the Edit Legend button to display
ogram the Legend Editor dialog. Move it so it doesn’t cover the view.
you 8. Click the Infrared button on the Legend Editor.

The theme Moscow_spot.tif draws in the view.
Apply a Histogram Equalize stretch to the image of Moscow

Standard Deviations is the default histogram stretch applied to images by the ArcView
Image Analysis extension. You can apply a Histogram Equalize stretch to redistribute
the data so that each display value has roughly the same number of data points. For more
information on the Standard Deviations or Histogram Equalize stretch, see Chapter 5,
“Enhancing image display.”

\ 1. Click the Advanced button at the bottom of the Legend Editor.

2. Move the Advanced Options dialog so that it does not cover the view. Notice the
position of the input (black) and output (color) histograms prior to the next step.
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The histogram of an image is a graphic depiction of the number of pixels (measured on
the Count axis) of each individual value (measured on the Value axis) that make up the
image. Look at the following example. The black histogram represents the input data fije
values. These values are the actual values that make up the data. The color histogram
represents the output values. These are the stretched values. You can alter the histogramg
of the image in a number of ways, including varying the type of histogram stretch
applied to an image.

breakpoints (yellow squares)

input histogram (black graph)

lookup table (yellow line)

output histogram (red graph)

This is an example of the histograms shown in the Advanced Options dialog.

3. From the Legend Editor, click the Stretch drop-down list and choose Histogram
Equalize. Click Apply.

4. Look at the histograms in the Advanced Options dialog. The values are now more
evenly distributed.

A Histogram Equalize stretch produces an image with increased contrast.
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don A histogram stretch uses the data file values of the input histogram and a lookup table to

p the reassign pixels to new output (or stretched) values of the display. The term stretch is used

ata file because the data values that make up the original image typically fall in a narrow range of

am the possible display values. The stretching of the input data file values changes the

grams brightness and contrast of the image as it is displayed in the view so features in the
image are more distinguishable.

5. Inthe Legend Editor, click and move the Brightness and Contrast slider bars either
right or left. Click Apply. Note how the histograms and image change.

6. You can experiment further with the position of the Brightness and Contrast slider
bars to see how they change the image. When you are done, click the Stretch drop-
down list and choose Standard Deviations. Click Apply. This will return to the
default stretch and prepare the image for the next set of steps in this exercise.

Apply an Invert Stretch to the image of Moscow

In this example, you apply the Invert Stretch to the image to redisplay it with its
brightness values reversed. Areas that originally appeared bright are now dark, and dark
areas are now bright. Take special note of how the Invert Stretch affects the lookup
tables in the Advanced Options dialog.

1. Inthe Legend Editor, check the Invert Stretch box. Click Apply.

nore

Invert Stretch creates a negative of the original image.

2. Look at how the histograms and lookup tables in the Advanced Options dialog have
changed. Click Undo in the Advanced Options dialog. The image is redisplayed
with a Standard Deviations stretch applied to it. i

3. Close the Advanced Options dialog and the Legend Editor.
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You can apply different types of stretches to your image to emphasize different parts of
the data. Depending on the original distribution of the data in the image, one stretch may
make the image appear better than another. The ArcView Image Analysis extension
allows you to rapidly make those comparisons. The Advanced Options dialog can be
used as a learning tool to see the effect of stretches on the input and output histograms.
You’ll learn more about the stretches, lookup tables, and breakpoints in Chapter 5,
“Enhancing image display.”

Close the view

You can now close the view and go on to the next exercise, or you can end your ArcView
GIS session. To end your ArcView GIS session, click the File menu and choose Exit.
Click No when asked to save changes.

Exercise 2: Identifying similar areas in an image

i With the ArcView Image Analysis extension, you can quickly identify areas with similar
characteristics. This is useful for identification of, for example, environmental disasters
or burn areas. Once an area has been defined, it can also be quickly saved into a
shapefile. This avoids the need for manual digitizing. To define the area, you use the
Seed tool to point to an area of interest, for example, a dark area on an image depicting
an oil spill. The Seed tool returns a graphic polygon outlining areas with similar
characteristics.

: Add and draw an Image Analysis theme depicting an oil spill
| 1. If necessary, start ArcView GIS and load the ArcView Image Analysis extension.
2. Open a new view and click the Add Theme button [

3. Navigate to the avtutor directory. Double click on the ia_data directory under the

avtutor directory. v'/g.f(L '/A /,61830\ MW\ A __04 .
4. Click the Data Source Types drop-down list and choose Image Analysis Data
Source.

5. Double click on radar_oilspill.img to add it as a theme.

6. Click the check box to draw the theme in the view.
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This is a radar image showing an oil spill off the northem coast of Spain.
Click inside the oil spill

In this exercise, you use the Seed tool. The Seed tool grows a polygon graphic in the
image that encompasses all similar and contiguous areas. This can be accomplished by
either pointing and clicking on an area of interest or by clicking and dragging a rectangle
over a particular area. In this example, you point and click inside the oil spill.

1. Click the Zoom In tool and drag a rectangle around the black area to see the
spill more clearly.

2. From the Image Analysis menu, choose Seed Tool Properties.

3. Inthe Seed Radius text box, type a Seed Radius of “10” pixels, then uncheck the
Include Island Polygons box.

The Seed Radius is the number of pixels surrounding the target pixel. The range of

values of those surrounding pixels is considered when the Seed tool grows the polygon.

4. Click OK in the Seed Tool Properties dialog.

5. Click the Seed tool [, then click a point in the center of the oil spill. The Seed
tool takes a few moments to produce the polygon.

Detailed information about the area is provided in the Status bar of the ArcView GIS
window. You can see how much area the oil spill encompasses.
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Exercise 3:

Zs'he darea within the outlined polygon is both similar and contiguous to the point you clicked with the
eed tool.

As you can see, the Seed tool is a very useful means of identifying the extent of the oil
spill. Now an emergency team could be informed of the extent of this environmental
disaster.

In this exercise, you have seen how you can quickly identify areas with similar
characteristics in an image using the Seed tool. It is also possible to place those features
extracted with the Seed tool into a shapefile. To learn more about feature extraction and
use of the Seed tool, see Chapter 8, “Feature extraction.”

Close the view

You can now close the view and go on to the next exercise, or you can end your ArcView
GIS session. To end your ArcView GIS session, click the File menu and choose Exit.
Click No when asked to save changes.

Aligning an image to a feature theme

You may want to use both an Image Analysis theme and a feature theme, such as a road
network, during your analysis. Sometimes the two may not share the same coordinate
space and may not overlay each other. You can use the Align tool to easily correct the
alignment of, or rectify, Image Analysis themes that do not overlay when drawn in the
view. In the following example, you use an image of Seattle, Washington, and a feature
theme that corresponds to the same area.
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Note This exercise is easier to complete if the ArcView GIS window and view are large.
Depending on your screen resolution, the results you see in the view may not exactly
match those shown in this exercise.

Add a feature theme of Seattle roads

1.
2.
3.

If necessary, start ArcView GIS and load the ArcView Image Analysis extension.
Open a new view and click the Add Theme button .

Navigate to the avtutor directory. Double click on the ia_data directory under the

avtutor directory. \/* \ (;g ﬂ, i\ A'VI" 6 1S 30 /h/ WJ’Z‘(_\ _I4 .y A.m

Click the Data Source Types drop-down list and choose Feature Data Source.

Double click seattle.shp to add it to the view.

Change the legend of the feature theme

1.
2.

Double click the title of the Seattle.shp theme to access the Legend Editor.

Double click the line Symbol to access the Pen Palette. Click the Size drop-down list
and choose 1.

Click the Color Palette button . Choose bright orange from the Color Palette.
Close the Color Palette.

In the Legend Editor, click Apply. Close the Legend Editor.
Click the check box for the Seattle.shp theme to draw it in the view.

The road feature theme has the map coordinate system to which you will align the image.
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Add and draw an Image Analysis theme of Seattle
1. Click the Add Theme button [}

2. Navigate to the avtutor directory. Double click on the ia_data directory under the

avtutor directory. /1 \ g AN\ Av_'é [S 30\ A"‘/ nfmt\ W )

3. Click the Data Source Types drop-down list and choose Image Analysis Data
Source.

4. Double click seattle_photo.tif to add it to the view.

5. If the Calculate Pyramid Layers dialog appears, click Yes to calculate pyramid layers.
In the event this dialog does not appear, it is because the image has previously built
pyramid layers.

Note For more information about pyramid layers, see Chapter 3, “Data types and data
management.”

‘ 6. Drag the Seattle_photo.tif theme below the Seattle.shp theme in the Table of
Contents.

7. Make the Seattle_photo.tif theme active and click the check box to draw it in the view.

After you click the check box for the Seattle_photo.tif theme, you’ll notice that it does not
draw in the view. This is your first indication that the image and the feature theme need to
be aligned.

8. Click the Zoom to Full Extent button .

. View3

- r
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This illustration shows how the image and the feature theme initially draw in the view.
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9. Move your mouse over the lower portion of the view (the location of the Image
Analysis theme). You see that the coordinates are small because images, before
rectification, are usually not in a map coordinate system. If you move the mouse
over the upper portion of the view (the location of the feature theme), the
coordinates are large. You’ll use the Align tool to make the image and the feature
theme draw in roughly the same area in the view.

Apply the Align tool to the image of Seattle

1. Make sure the Seattle_photo.tif theme is active in the view.

2. From the view’s toolbar, click the Align tool .

The first application of the Align tool moves the image to the feature theme so they both appear in
the view.

Create the first of four control point pairs in the image and the feature
theme

Once you’ve clicked the Align tool and the image and the feature theme both draw in the
view, you’'re ready to start collecting control point pairs. Control points are distinctive
landmarks and road intersections that can easily be identified on both the feature theme
and image views. The locations of the control points allow the ArcView Image Analysis
extension to align the two themes. Once each control point pair, or link, is selected, you
get immediate visual feedback to validate your choice.
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The area you will zoom in on is indicated with a circle.

1. Move your cursor over the area indicated with the circle in the previous illustration.

2. Click the right mouse button and select Zoom to Image Resolution. The area you
clicked is centered in the view.

The illustration above shows where you will collect the first control point in the image and the feature

theme. The From point, which is circled, has an arrow to the To point, also circled.

3. Click on the intersection of the streets in the Seattle_photo.tif theme. The point in the
image is the From point. Move your cursor and notice a rubber-banding line
indicating you are going to collect the To point next.

4. Click the same intersection in the Seattle.shp theme. It is slightly to the right of the
intersection in the image. This is the To point. After you click the To point, the
image shifts to make the From and To points align.
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Note If at any time you get undesired or unexpected results from adding a link, press the
DELETE key to go back to the previous state. If you want to delete your initial control
point (the From point), you must enter the second control point (the To point) before
using the DELETE key to eliminate the unwanted control point pair.

Notice how the image is aligned to the feature theme in the area where you selected the control
point pair. The pair is indicated by a red dot.

5. Click the right mouse button and choose Zoom to Active Theme(s). This will allow
you to see the entire image so the next set of control points can be identified.

Create the second control point pair

1. Make sure that the image, the Seattle_photo.tif theme, is active in the view.

The area you will zoom in on is indicated with a circle.
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2. Move your cursor over the area indicated with the circle in the previous illustration.

3. Click the right mouse button and select Zoom to Image Resolution.

Note If the From or To location is off the screen, use the right mouse button and select
i Pan to locate the point.

The illustration above shows where you will collect the second control point in the image and the

feature theme. The From point, which is circled, has an arrow to the To point, also circled. To create

this illustration, Zoom Out was applied so that both points fit in the view. Thus, the resolution is 1:1.3.

Your image resolution will be 1:1 after applying Zoom to Image Resolution.

4. Using the illustration of the image and the feature theme as a guide, click the
intersection of the freeway ramps and surface streets in the Seattle_photo.tif theme.
This is a From point.

5. Click the same intersection in the Seattle.shp theme to create a To point.

This illustration shows the image and feature theme alignment is improving.




Chapter 2 Quick start tutorial 25

6. Click the right mouse button and choose Zoom to Active Theme(s) to prepare for the
identification of the third control point pair.

Create the third control point pair

1. Make sure that the image, the Seattle_photo.tif theme, is active in the view.

L
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The area you will zoom in on to collect your third control point is indicated with a circle.

2. Move your cursor over the area indicated with the circle in the previous illustration.
You will see a street with a noticeable bend.

3. Click the right mouse button and select Zoom to Image Resolution.

The illustration above shows where you will collect the third control point in the image and the feature
theme. The From point and the To point are both indicated with a circle.
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4. Using the illustration of the image and the feature theme as a guide, click on the
intersection in the Seattle_photo.tif theme to create a From point.

5. Click the same intersection in the Seattle.shp theme to create a To point.

j > You can see the third control point pair you collected indicated by the red dot.

6. Click the right mouse button and choose Zoom to Active Theme(s) so the fourth
< and final control point pair can be identified.

! Create the fourth control point pair

1. Make sure that the image, the Seattle_photo.tif theme, is active in the view.

-
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] The part of the image you will zoom in on is indicated with a circle.
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2. Move your cursor over the area indicated with the circle in the previous illustration.
In the feature theme, you can see a city block shaped like an upside-down and
backwards “L”.

3. Click the right mouse button and select Zoom to Image Resolution. The area you
clicked is centered in the view.

The illustration above shows where you will collect the fourth control point in the image and the

feature theme. The From point and the To point are both indicated with a circle.

4. Using the illustration of the image and the feature theme as a guide, click the 1
intersection of the road to the right of the large building in the Seattle_photo.tif
theme. This creates a From point.

5. Using the illustration of the image and the feature theme as a guide, click the same
intersection in the Seattle.shp theme. This creates a To point.

After collecting the fourth control point, the image very closely matches the feature theme.
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Once at least four control point pairs are collected, the RMS error is displayed in the
status area of the ArcView GIS window. An RMS €1TOor, Or root mean square error, is the
distance measured in pixels between the input location (From point) and the rectified
location (To point), after having applied the current transformation. The lower the RMS
error during rectification, the more closely the feature theme and the image align.

6. Notice the RMS error reported in the status area of the ArcView GIS window. In this
example, the RMS error is 3.96. Yours will likely be different, based on the exact
placement of your control points.

7. Click the right mouse button and choose Zoom to Active Theme(s) to view the
feature theme and image now that it is aligned.

y 17 T
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Usually you'll only need four control point pairs to accurately align an image to a feature theme.
Save the control points and create a new image

The ArcView Image Analysis extension gives you the option of saving the control points
as a shapefile. You are going to save the control points you created in this part of the
exercise. You are also going to create a copy of the original image with the correct
alignment. The process is called resampling. That means that the original image,
Seattle_photo.tif, will not be changed.

1. Make sure the Seattle_photo.tif theme is active in the view.
2. From the Theme menu, choose Save Image As.

3. In the Save Control Points dialog box, click Yes to save the control points as a
shapefile.

4. In the Save Control Points dialog, navigate to the directory where you want to save
’ » the control points. Type the name “seattle_cp.shp”, and click OK.

! : 5. In the Add to View dialog, click Yes to add the control point shapefile to the view.
|
l
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6. In the Save As dialog that appears, navigate to the directory where you want to save
a copy of the rectified image.

7. Click the List Files of Type drop-down list and choose IMAGINE Image.
8. In the File Name text box, type the name “seattlealign.img”, and click OK.

The resampling process takes a few moments. You can watch the progress bar in the
status area of the ArcView GIS window.

9. Inthe Add to View dialog, click Yes to add the resampled image to the view.

Draw the control point shapefile in the view
1. Make sure the Seattle_photo.tif theme is the only active theme in the view.

2. From the Edit menu, choose Delete Themes. Click Yes in the Delete Themes dialog to
delete the Seattle_photo.tif theme.

3. Make the Seattle_cp.shp theme active, then click the check box to draw it in the view.
The four control point pairs will be symbolized as four dots, as shown below.
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5. Scroll through the table to see the Point coordinates and RMS errors. This file can
be used for historical reference as to how well the rectification process was
performed. Then other users of this data would know if its accuracy would meet
their data requirements.

6. 'When you have finished, close the Attribute table for Seattle_cp.shp.
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Display the aligned image of Seattle in the view
1. Drag the Seattlealign.img theme below the Seattle.shp theme in the Table of Contents.
2. Click the check box of the Seattlealign.img theme to draw it in the view.
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This shows that the image you saved can now be used with the feature theme without going through
the alignment process again.

3. Click the Zoom to Image Resolution button [

4. Click the Pan tool and move around the image to see the fit between the image
and the feature theme.

You can zoom to image resolution to see the fit between the image and the feature theme after using
the Align tool.

TN LANT = (e I
| Auiowen /o AECTIIE0 ImA




